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File Explorer is the central hub for file management in Windows 11, empowering users to organize, access, and find files and folders efficiently. Mastering its keyboard shortcuts can significantly enhance productivity by reducing reliance on the mouse and accelerating everyday tasks. This article presents a comprehensive list of File Explorer
keyboard shortcuts in Windows 11, categorized for quick reference and accompanied by practical tips for their effective use. Windows 11 File Explorer Windows key + E: Open File Explorer. Ctrl + N: Open a new File Explorer window. Ctrl + W or Ctrl + F4: Close the current File Explorer window. Ctrl + Shift + N: Create a new folder. Alt + D: Select
the address bar. Ctrl + L: Also select the address bar. Ctrl + Tab: Switch to the next tab (if using tabbed navigation). Ctrl + Shift + Tab: Switch to the previous tab. Ctrl + T: Open a new tab. Ctrl + W: Close the current tab. Alt + Left Arrow: Go back to the previous folder. Alt + Right Arrow: Go forward to the next folder. Alt + Up Arrow: Go up one
folder level. F4: Display the address bar list. F3: Search for a file or folder. Ctrl + F: Also search within the window. Tab: Move forward through options. Shift + Tab: Move backward through options. End: Go to the bottom of the window. Home: Go to the top of the window. Up Arrow/Down Arrow: Move up or down through items. Left Arrow/Right
Arrow: Collapse or expand the current folder (in the navigation pane).Ctrl + A: Select all items in the current window. Ctrl + Click: Select multiple individual items. Shift + Click: Select a range of items between two points. Shift + Arrow Keys: Extend selection by one item at a time. Ctrl + Shift + Arrow Keys: Extend selection to the first or last item in
a group. Ctrl + Spacebar: Select or deselect the focused item. Spacebar: (with focus on an item) Toggle selection of the item. F2: Rename selected item. Delete: Move selected items to the Recycle Bin. Shift + Delete: Permanently delete selected items without moving to the Recycle Bin. Ctrl + C: Copy selected items. Ctrl + X: Cut selected items. Ctrl
+ V: Paste copied or cut items. Ctrl + Z: Undo an action. Ctrl + Y: Redo an action. Ctrl + Shift + N: Create a new folder. Ctrl + Shift + E: Expand all folders in the navigation pane. Alt + Enter: Open properties of the selected file or folder. F6: Cycle through elements in the window.Ctrl + Shift + 1/2/3/4/5/6/7/8: Change folder view (Extra large icons,
Large icons, Medium icons, Small icons, List, Details, Tiles, Content). Ctrl + Shift + E: Display all folders (navigation pane). Alt + P: Show or hide the preview pane. Alt + Shift + P: Show or hide the details pane. Ctrl + Shift + N: Create a new folder. Alt + F, then O: Open the File menu, then open a new window. Alt + F, then S: Open the File menu,
then access settings. Alt + V, then D: Switch to details view. Alt + V, then L: Switch to list view. Alt + V, then N: Switch to navigation pane.F3: Search File Explorer. Ctrl + F: Search within the current folder. Ctrl + E: Focus on the search box.Alt: Show Key Tips for ribbons and menus. Alt + F: Open the File menu. Alt + H: Open the Home tab. Alt +
N: Open the Share tab. Alt + V: Open the View tab. Alt + Y: Open contextual tabs (when available). Alt + Enter: Open Properties dialog.Alt + Z: Add current folder to Quick Access. Alt + Up Arrow: Go up to parent folder. Ctrl + D: Pin current folder to Quick Access.F11: Enter or exit full-screen mode. Ctrl + Shift + Esc: Open Task Manager (works
everywhere, useful if File Explorer freezes). Ctrl + Shift + Number (1-8): Change folder view modes. Alt + Space: Open window menu (move, size, minimize, maximize, close). Shift + F10: Opens context menu (same as right click). Right Arrow (in navigation pane): Expand current folder. Left Arrow (in navigation pane): Collapse current folder. Ctrl +
Mouse Wheel: Zoom in and out in file/folder view. Practice and mastering the above keyboard shortcuts in Windows 11s File Explorer can immensely improve your efficiency. Below are some additional tips for effective usage: Combine shortcuts for even faster navigation: For example, use Ctrl + Shift + N immediately after opening a folder to create
new subfolders quickly. Use Alt + D or Ctrl + L to jump to the address bar, then type folder paths directly for rapid access. Employ Tab and Shift + Tab to move through different sections like the navigation pane, file list, and ribbon without touching your mouse. Customize your view using Ctrl + Shift + Number shortcuts to switch between icon and
list views, depending on your needs. Remember that Ctrl + Z and Ctrl + Y can undo and redo nearly any action, providing a safety net for swift file management. Tags: File ExplorerKeyboard File Explorer is one of the most crucial tools in Windows 11, as it lets you browse and manage files stored on your computer. This is the tool that allows you to
browse all the files on your PC, so you can open, delete, rename them, and much more. If you've been using Windows laptops for a while, using File Explorer may feel like second nature to you, but you might be surprised at just how much you don't know. And if it's the first time using Windows in a while, then there's a lot you'll want to learn about.
This guide will show you everything you need to know to get to grips with it, from the most basic functionality to more advanced settings even more frequent users may not know. This guide is based on the latest version of File Explorer in Windows 11 version 23H2 and newer. Older versions may look different, but the core functionality is similar.
Related Want to customize your context menus? Here's how How to open File Explorer You can open File Explorer on Windows 11 in a few ways: Option 1: Click the File Explorer icon on the taskbar Option 2: Press Windows + E on your keyboard Option 3: Open the Start menu and search for File Explorer Option 4: Press Windows + R to launch the
Run window and then enter explorer Option 5: Right-click the Start button and select File Explorer When you first open File Explorer, there are a few main UI elements you'll want to take note of. Let's take a look at the main File Explorer window. There are a few primary elements you'll want to get familiar with here: Tab bar: You'll see the titles of
your open tabs and you can switch between them here (only available in Windows 11 version 22H2 or newer). Navigation buttons: Includes back, forward, up, and refresh buttons. Address bar: Shows the current path in the main view and lets you navigate the folder structure. Search bar: Lets you search for items in the current view (including sub-
folders). Ribbon: The ribbon contains file management tools like copy, cut, delete, and rename, as well as filtering and sorting options for your current view. Options shown in the ribbon depending. Navigation pane: Shows the folder structure of your PC and highlights the current folder in the main view. Main view: Shows you the files and folders in
the path you're currently in. You can double-click a file or folder to open it. Navigate to the folder or file you want to copy. Right-click the file or folder and choose Copy from the context menu. Alternatively, click the file once and then press Ctrl + C to copy it, or click Copy in the ribbon. Navigate to the folder where you want to copy the file. Right-
click an empty area of the main view and choose Paste. You can also press Ctrl + V to paste a file, or click Paste in the ribbon. Navigate to the folder or file you want to move. Right-click the file or folder and choose Cut from the context menu. Alternatively, click the file once and then press Ctrl + X to cut it, or click Cut in the ribbon. Navigate to the
folder where you want to move the file. Right-click an empty area of the main view and choose Paste. You can also press Ctrl + V to paste a file, or click Paste in the ribbon. If you have multiple windows or tabs open, you can also click and drag a file from one location to another to move them. Navigate to the file you want to delete Right-click the file
and click Delete. You can also click the file and click Delete in the ribbon, or press the Delete key on your keyboard. Using tabs in File Explorer works similarly to how most modern web browsers work. Here's how it works: Open a new tab Option 1: Click the + (plus) button in the tab bar. Option 2: Press Ctrl + T on your keyboard. Open a folder in a
new tab Option 1: Right-click a folder in the main view or navigation pane and click Open in new tab Option 2: With a desktop mouse, click the scroll wheel (middle-click) a folder to open it in a new tab. Close a tab Option 1: Click the small X button next to the tab title (not to be confused with the large X in the top right corner of the window). Option
2: Press Ctrl + W on your keyboard to close your active tab. Option 3: With a desktop mouse, click the scroll wheel (middle-click) an open tab to close it. Re-order tabs Option 1: To move tabs on the tab bar, click and drag them to the position you want them in. Option 2: To move tabs to a separate window, click and drag the tab outside the File
Explorer window, then release it. Move files between tabs Click and hold the file or folder you want to move. Drag it over the tab you want to move it to and hold it until the main view switches to that tab. Drag the file to the main view. File Explorer hides extensions for known file formats by default. If you'd like to see them, use these steps: Click the
View option in the ribbon Hover over Show and then choose File name extensions. Certain files can be hidden from view in File Explorer. To see them, do this: Click the View option in the ribbon. Hover over Show and then choose Hidden items. The Home page in File Explorer shows the files and folders that are most relevant to you across three
sections: Quick Access, Favorites, and Recent: Pin or unpin folders from Quick access Quick access contains your pinned folders as well as frequently visited folders. A few folders are pinned by default, like Pictures, Videos, and Downloads. To unpin a folder you don't want to see here: Right-click the folder you want to unpin. Click Unpin from Quick
access. On the other hand, to pin new folders to Quick access, follow these steps: Navigate to the folder you want to add to Quick access. Right-click the folder and choose Pin to Quick access. Hide frequent folders from Quick access To hide frequently visited folders from the Quick access section, do this: Click the ellipsis icon in the ribbon and choose
Options. Uncheck the box labeled Show frequently used folders. Click OK. This way, you'll only see pinned folders. Add files to Favorites Similarly to pinned folders, you can add individual files to your favorites to have them appear on the Home page. Navigate to the file you want to add to your favorites. Right-click it and choose Add to Favorites.
You'll now see it under the Favorites section of the Home page. To remove a favorite file, right-click it and choose Remove from Favorites. Hide recent files Finally, the Recent section shows files you've recently opened. If you don't want this section to appear, follow these steps: Click the ellipsis icon in the ribbon and choose Options. Uncheck the box
labeled Show recently used files. Click OK. Hide online files The Recent section can also show documents you have stored in OneDrive. If you only want to see local files: Click the ellipsis icon in the ribbon and choose Options. Uncheck the box labeled Show files from Office.com. Click OK. If you don't like the new context menu in Windows 11's File
Explorer: Right-click any folder or file you want to act on. Click Show more options. Alternatively, you can hold Shift on your keyboard and right-click with the mouse to see the classic context menu right away. Related The new context menu isn't for everyone Microsoft has completely redesigned the File Explorer in Windows 11. Its got a sleek and
refreshing interface, a Command Bar at the top with the relevant icons, an uncluttered context menu, however, Microsoft has not done away with the legacy context menu and it can still be accessed. With a plethora of changes, it would take you some time to get acquainted with them all. But once you do, working on Windows would be much simpler
and convenient. We did expect some changes in the File Explorer, most are there on Windows 11 while the wait for others continues. Lets see what all changes are introduced to the new File Explorer and how to perform various actions and functions on it. File Explorer Interface When you first launch File Explorer on Windows 11, its a refreshing
feeling. With a clean look coupled with a centered Taskbar, Microsoft has no doubt got the interface right. Theres the new Command Bar at the top, with just the relevant icons. Since the number of options that could be directly accessed are far less, the Command Bar occupies lesser space. Then there are new icons, bright and appealing (these are
also present in recent Windows 10 updates as well). We have some addition to the icons as well. On the first look, it appears to be a complete overhaul of File Explorer. Lets delve deeper, identify the other changes, and learn how to use the new File Explorer. Command Bar The Command Bar at the top is pretty neat with just the icons to perform
relevant tasks. Unlike the previous versions which had options categorized under three tabs, here (in the new command bar) all the options can easily be accessed. Also, the options in the Command Bar depend on the type of file you have selected. In case its an image the option to Set as Background and Rotate right will be added, while for most of
the other file formats and folders, it remains the same as below. Lets see how you perform actions with the Command Bar. Creating a New Folder or Item To create a new folder or item, click on the New option at the extreme left of the Command Bar. In the drop-down menu, you have two options, either to create a folder or add a new item. The first
option, i.e. New folder, is self-explanatory, but if you hover the cursor over New Item, a new menu with a list of items will appear, although, there is a Folder option here as well. Cut, Copy, or Paste a File or Folder To copy and paste a file or folder, select the file and click on the relevant icon in the Command Bar. Once you have either cut or copied a
file, the Paste icon wont be greyed out anymore. Navigate to the location where you want to paste the file and click on the Paste icon in the Command Bar. Rename a File Folder To rename a file or folder, select the file you want to rename, click on the Rename icon from the Command Bar or right-click on the file and click on the Rename icon there.
Then, enter a new name for the file, and press ENTER. Delete a File/Folder To delete a file on the new File Explorer, select the file(s), and click on the Delete icon at the top or right-click on the file and click on the Delete icon in the context menu. Share Files from the File Explorer To share files with the new File Explorer, select the file, click on the
Share icon and three options will appear on the screen. Nearby sharing: You can use this feature to share files with other nearby Windows devices. Just enable the feature on both the devices and share files between the two.Email a contact: If you have set up the Mail app on Windows 11, your contact list will be displayed here and you can share the
file over email.Share with app: This option helps you share files over apps installed on your computer. Sort and Group Options Windows 11 has made sorting and grouping the files and folders a lot simpler and convenient. Just click on the Sort and group option icon and the first four options would be to sort the files/folder. If you dont want to sort the
files according to the first three, hover the cursor over More and select another sorting option. The option thats currently set has a dot before it. The next two options, Ascending and Descending, decide the sort order. Ascending: The files with the lowest value of the sorting parameter are listed at the top.Descending: The files with the highest value
of the sorting parameter are listed at the top. The last option Group by help you group the files and folders. Hover the cursor over the option and a new menu with various grouping choices will appear. Select the desired one from the list. Layout and View Options The penultimate option in the Command Bar is the Layout and view options. It helps you
choose the layout for the files and folders and to select which files are to be displayed. When you click on the Layout a view options icon in the Command Bar, it launches a drop-down menu. The first eight options in the drop-down menu decide the layout for the various files/folders for the location thats currently open. When you select Compact view,
the space between the various items decreases. It applies both to the items listed in the folder and those in the navigation pane. The last option, i.e., Show, lists the various panes, features and items that can easily be enabled or disabled. For instance, if you want to add Checkboxes to the files/folders for easy selection, choose the option. Or if you
want to view the hidden files, select the Hidden items option. The options did exist earlier, they have just been positioned differently on Windows 11. More Options The last icon in the Command Bar is the ellipsis which opens a drop-down menu that lists several extra options. The number of options varies depending on whether a file or folder has been
selected or if none has been selected. When you select a file, another option Copy path with added under More options, and in the case of a folder, the option Compress to ZIP file will be added, in addition to Copy path. The options here are all self-explanatory and you will get a hang of each within a few moments. New Context Menu Gone are the
days of a messy context menu where locating an option seemed like a task in itself, let alone performing the action. Windows 11 has introduced a new simplified Context Menu, one where all the icons and options can be distinguished in a single glance. We now have icons for multiple actions in the context menu. However, for those of you who prefer
the legacy Context Menu, it can still be accessed on Windows 11. Microsoft has not removed it from the latest version, however, the new Context Menu is much simpler and easy to work on. Lets see the various options in the new context menu. Note: As was the case with Command Bar, the options in the context menu depends on whether you have
selected a file or a folder, and the file format. The icons for cut, copy, paste, rename, and delete, that were present in the Command Bar are added to the new context menu as well. These icons can be present either at the top or bottom of the context menu. Users who still have their hands set on Windows 10 can access the legacy context menu by
selecting Show more options or press SHIFT + F10. The other options in the context menu are self-explanatory. Navigation Pane As discussed earlier, there have been no major changes to the Navigation Pane on the left. It works the same way as those in the previous versions, helping you quickly navigate through the various folders on the system.
You can pin items to Quick Access to have them accessible with a single click. However, when you right-click on any item in the Navigation Pane, it launches the new context menu, the one we saw earlier. Improved Theme Support in File Explorer For those of you who like to experiment with themes to enhance the Windows experience, Windows 11
surely has a lot to offer. Check out the various themes in the Personalization settings. Like the Dark theme, its not new (has been in Windows 10 too), but its much better now in Windows 11. To change themes in Windows 11, press the Windows logo key to launch the Start Menu, enter Settings, and then click on the relevant search result to launch
the app. In Settings, click on Personalization at the left. Now, you can either select one of the themes listed at the top or select the Themes option to customize the theme or download more from the Store. We tried the dark theme on Windows 11 and it works like a charm for File Explorer. Troubleshooting Issues with the New File Explorer Many
users who have switched to Windows 11 reported being unable to access the new File Explorer, instead, it was the old File Explorer that launched. If thats the case with you, here are some quick and effective fixes. 1. Restart the Computer Restating the computer helps fix most of the trivial errors. When you restart the computer, the OS is reloaded
which fixes any minor glitch that was preventing access to the new File Explorer. After restarting the computer, check if get access to the new File Explorer. In case its the old one that loads, move to the next fix. 2. Change File Eplorer Options Theres a setting to launch folder windows in a separate process for File Explorer. In case its enabled,
Windows 11 will launch the old File Explorer. Heres how you disable it. Press the WINDOWS key to launch the Start Menu, search for File Explorer Options and then click on the relevant search result. Next, navigate to the View tab, locate Launch folder windows in a separate process, untick the checkbox for it and finally click on OK to save the
changes. Now, check if you are able to access the new File Explorer. 3. Uninstall Link Shell Extension The Link Shell Extension application has been found to cause this issue on Windows 11. If you have it installed on the system, uninstall it and check if the error is fixed. 4. Update Graphics Driver If none of the above fixes have worked, its time you
update the Graphis Driver. Running an outdated version of the driver can also lead to errors and affects the performance of the system as well. To update the Graphics Driver, go to How to Update Drivers in Windows 11 and check the How to Update Graphics Driver in Windows 11 section. After updating the Graphics Driver, check if the error is fixed
and you are able to access the new File Explorer. In all likelihood, the above fixes should resolve the error. But, in case it persists, you have no option but to wait for an update. With each update, Windows try and fix the various bugs. Wait and see if the error is fixed in the subsequent updates. Thats all theres to the new File Explorer on Windows 11.
Just keep exploring the various options and settings and you will get acquainted with the new interface in no time. Among tons of visual changes and new features, Windows 11 completely overhauled the File Explorer app to make it more productive than ever. To help you master it, we have picked the best Windows 11 File Explorer tips, tricks, and
hidden hacks to harness its useful features. Stick with this guide till the end to make the most of it. Additionally, you can learn to fix the File Explorer app on Windows 11 if it is not responding.Top Windows 11 File Explorer Tips, Tricks, and Hidden HacksBelow we have curated the list of the best Windows 11 File Explorer tips, tricks, and hacks to
master them in no time. So without any further adieu lets get started.Maximize Productivity by Arranging Apps in GroupsSimilar to the Androids split screen feature, the Windows file explorer app allows you to arrange and use multiple apps (in a group) on a single screen in Windows 11. Consequently, you can group up to four different apps on a
single screen. Heres how:1. Open the File Explorer app and hover your mouse cursor over the Maximize/Minimise Window icon to see predefined group layouts.2. Next, pick your preferred grouping layout and open your desired app inside each split window to use them simultaneously.Open Multiple Tabs in Windows File ExplorerGone are the days
when you had to open a separate window to access each file. Now, you can open multiple tabs inside a single File Explorer window to conveniently navigate and access your files like a web browser. Heres how to use it:1. Open the File Explorer window and click on the + icon to open a new tab.2. Next, browse and access your desired file in the newly
opened tab. You can switch back to the previous directory by pressing the former tab.Change Default File Explorer LocationWhen you open the File Explorer app, it opens the Home tab by default, making it irritating to manually access disk drives on the This PC tab each time. Luckily, you can change it by configuring the File Explorer settings. Heres
how:1. Open the File Explorer app and click on the three-dot icon next to the View tab to access Options.2. Now, click the Open File Explorer to option and set it to This PC.3. Finally, press the Apply button to save changes.Control Privacy for the Quick Access MenuThe Quick Access menu in the Windows File Explorer app has the ability to show
frequently or recently used items on your system. If you share your system with your friends/family, at times you might feel uncomfortable disclosing this recent information. Luckily, the updated file explorer app allows you to exclude it. Follow these steps for an easy fix:1. Open the File Explorer app and click on the three-dot icon next to the View tab
to access Options.2. Here, toggle off the checkboxes for Show Recently Used Files and Show Recently Used Folders.3. Finally, press the Apply button to save changes.Show/Hide File Name ExtensionsBesides quick access, the File Explorer app in Windows 11 allows you to show/hide extensions next to the file names to facilitate easy identification.
Heres how you can enable or disable the same:1. Go to your desired file directory with the explorer app and click on the View tab at the top.2. Hover your mouse cursor over the Show option and click on File Name Extensions to enable it.3. You can now see extensions next to each file name in the directory. To disable the extension, repeat the same
steps.Personalize Folder and File AppearanceSimilar to Windows 10, you can change the appearance of files and folders in Windows 11 to make them more readable. Follow these easy steps to personalize the same:1. Open the File Explorer app and click the View tab in the toolbar at the top.2. Next, choose your desired icon size from the list to
increase readability. An extra large icon size will show the entire image/folder as a preview thumbnail, while a small icon size will conserve the space to view more items.3. Similarly, you can pick from four pre-defined layouts, namely, list, details, tiles, and content, to organize files and folders inside a directory.You can also follow our guide to Install
the macOS Quick Look Feature on Windows to help you easily view a files contents without actually opening it.Rotate Images without Opening ThemWith the new File Explorer update in Windows 11, you can rotate images without opening them. In addition, you can select multiple files in bulk to rotate them instantly with a single click. Heres how:1.
Select your desired image(s) using the file explorer app and click on the Rotate button in the toolbar at the top. You can either rotate the image to the left or right by clicking their respective buttons.2. Once rotated, you can preview the image using the file thumbnail without opening it.Change System Background with a ClickSwitching to a new
system background is as easy as eating a cake with the new Windows file explorer app. Simply select the image you wish to set as your background and then click the Set As Background button at the top to apply it.A Versatile Right-Click Context MenuThe new File Explorer app in Windows 11 intelligently recognizes the file type and provides useful
suggestions to handle it. Consequently, the context menu differs based on file type to manage each file and folder in the directory. In addition, the menu offers quick toggle buttons for cutting, pasting, renaming, sharing, and deletion in its header or footer section to save you precious time. However, if you prefer the old right-click context menu (like
Windows 10) instead of the new UlI, you can check out our guide to get back the old right-click context menu on Windows 11.More Powerful Search Bar than Ever BeforeBesides searching individual files, the new search bar in the Windows 11 file explorer app can search similar file types with a keyword. For example, if you type folder in the search
bar of a file directory, you will view all the folders inside it. Similarly, if you type Image in the search bar and hit the enter key, the file explorer will show you all the image files present in your searched directory. This can be useful when you are searching for a similar file type among the vast ocean of files and folders in your directory.Select Multiple
Files with CheckboxesOften while selecting multiple files, we accidentally drag the mouse cursor or release the control key, losing the focus of the selected items. Not anymore; as the new File Explorer app on Windows 11 now offers the checkboxes feature enabling you to select multiple files by clicking the checkbox located at the top of each item.
Heres how you can enable it:1. Navigate to your desired file directory and click on the View tab and enable the Item CheckBoxes under the Show feature.2. To select multiple items using the checkbox, hover your mouse cursor to the top-left corner of each file icon and click the checkbox button to select it.3. Repeat the above step to select multiple
files in your current directory.Rename Files in Bulk in Windows File ExplorerWhile organizing screenshots or photos, we feel the need to rename them. Normally, you have to follow the time-consuming process of right-clicking each photo to rename it, but what if theres a quick way to do it? With Windows 11, the file explorer app allows you to rename
one file and press the Tab button to rename the immediate next neighbor. You can repeat this process quickly to rename multiple files sequentially.Preserve Screen Space with the Compact ViewlIf you feel that the new File Explorer Ul has too much padding between items, you can switch to the Compact layout to save space and view more items on a
single screen. This can be useful for your vertical screen setups. Heres how it can be done:1. Press the View tab in the toolbar at the top and click the Compact View option to enable it.2. Notice that the padding between items in the left sidebar and filenames has been decreased.Share Files Directly from the ExplorerSharing files with Windows 11
File Explorer is super convenient and quick. Right-click on your desired file and press the Share icon to send it to nearby devices or connected apps. You can also share it with the Feedback hub or Microsoft Teams for quick communication.Increase Productivity with File Explorer HotkeysLast but not least, you can master navigation through the
Windows File Explorer app with these hotkeys/shortcuts:FAQsQ: How to change Windows 11 File Explorer layout?A: You can access the View tab at the top to change the layout of files in the Explorer app.Q: Where can you access the settings for the Windows 11 File Explorer app?A: Simply press the three-dot icon next to the View tab and click on
Options to access the File Explorer app settings.Q: How to change the file icon size in the Windows 11 Explorer app?A: Click the View tab and choose your desired icon size in the list to improve readability. Refer to the above tips for detailed steps.Q: How to print a document from File Explorer in Windows 11?A: Right-click on the file and click on the
Show More option in the right-context menu. Here, you will find the option to Print your document.Wrapping Up: Become a Pro with Windows 11 File Explorer Tips!We hope youve picked some useful File Explorer features of Windows 11 through this guide, some of these features work on Windows 10 as well, or you can get Windows 11 file explorer
on Windows 10. If you find it helpful, share this read with your friends to boost their productivity to the next level. Stay subscribed to GadgetsToUse, and check the below links for more interesting Windows 11 walkthroughs.You might be looking for the following:You can also follow us for instant tech news atGoogle Newsor for tips and tricks,
smartphones & gadgets reviews, joinGadgetsToUse Telegram Group,or for the latest review videos subscribeGadgetsToUse Youtube Channel.Was this article helpful? Option Nine - Open File Explorer using File ExplorerlI've tried it! Enter explorer in the address bar, opens a new Explorer window. Option Nine - Open File Explorer using File
ExplorerI've tried it! Enter explorer in the address bar, opens a new Explorer window. Gotta open it first. OS Windows 11 Pro for Workstations Computer type PC/Desktop Manufacturer/Model Custom self build CPU Intel i7-8700K 5 GHz Motherboard ASUS ROG Maximus XI Formula Z390 Memory 64 GB (4x16GB) G.SKILL TridentZ RGB DDR4 3600
MHz (F4-3600C18D-32GTZR) Graphics Card(s) ASUS ROG-STRIX-GTX1080TI-O11G-GAMING (11GB GDDR5X) Sound Card Integrated Digital Audio (S/PDIF) Monitor(s) Displays 2 x Samsung Odyssey G75 27" Screen Resolution 2560x1440 Hard Drives 1TB Samsung 990 PRO M.2,4TB Samsung 990 PRO M.2,TerraMaster F8 SSD Plus NAS PSU
Seasonic Prime Titanium 850W Case Thermaltake Core P3 wall mounted Cooling Corsair Hydro H115i Keyboard Logitech wireless K800 Mouse Logitech MX Master 3 Internet Speed 1 Gbps Download and 35 Mbps Upload Browser Chrome and Edge Antivirus Microsoft Defender Other Info Logitech Z625 speaker system,Logitech BRIO 4K Pro
webcam,HP Color LaserJet Pro MFP M477fdn,CyberPower CP1500PFCLCDGalaxy S23 Plus phone Operating System Windows 11 Pro Computer type Laptop Manufacturer/Model Surface Laptop 7 Copilot+ PC CPU Snapdragon X Elite (12 core) 3.42 GHz Memory 16 GB LPDDR5x-7467 MHz Monitor(s) Displays 15" HDR Screen Resolution 2496 x 1664
Hard Drives 1 TB SSD Internet Speed Wi-Fi 7 and Bluetooth 5.4 Browser Chrome and Edge Antivirus Microsoft Defender I dont know how, but I never knew of the keyboard shortcut. Very helpful, thanks Shawn. OS Windows 11 Pro 23H2 Build 22631.5624 Computer type PC/Desktop Manufacturer/Model Sin-built CPU Intel(R) Core(TM) i7-4770K CPU
@ 3.50GHz (4th Gen?) Motherboard ASUS ROG Maximus VI Formula Memory 32.0 GB of I forget and the box is in storage. Graphics Card(s) Gigabyte nVidia GeForce GTX 1660 Super OC 6GB Sound Card Onboard thingy Monitor(s) Displays 5 x LG 25MS500-B - 1 x 24MK430H-B - 1 x Wacom Pro 22" Touch Screen Tablet Screen Resolution All over
the place Hard Drives Too many to list. OS on Samsung 1TB 870 QVO SATA PSU Silverstone 1500 Case NZXT Phantom 820 Full-Tower Case Cooling Noctua NH-D15 Elite Class Dual Tower CPU Cooler / 6 x EziDIY 120mm / 2 x Corsair 140mm somethings / 1 x 140mm Thermaltake something / 2 x 200mm Corsair. Keyboard Corsair K95 / Logitech
diNovo Edge Wireless Mouse Logitech: G402 / G502 / Mx Masters / MX Air Cordless Internet Speed 1000/400Mbps Browser All sorts Antivirus Kaspersky Premium Other Info TP-Link BE9300 WiFi 7 Bluetooth 5.4 (Archer TBE550E)Im on a horse. Operating System Windows 11 Pro 23H2 Build: 22631.4249 Computer type Laptop Manufacturer/Model
LENOVO Yoga 7i EVO OLED 14" Touchscreen i5 12 Core 16GB/512GB CPU Intel Core 12th Gen i5-1240P Processor (1.7 - 4.4GHz) Memory 16GB LPDDR5 RAM Graphics card(s) Intel Iris Xe Graphics Processor Sound Card Optimized with Dolby Atmos Screen Resolution QHD 2880 x 1800 OLED Hard Drives M.2 512GB Antivirus Defender /
Malwarebytes Other Info still on a horse. OS Windows 11 Pro for Workstations Computer type PC/Desktop Manufacturer/Model Custom self build CPU Intel i7-8700K 5 GHz Motherboard ASUS ROG Maximus XI Formula 2390 Memory 64 GB (4x16GB) G.SKILL TridentZ RGB DDR4 3600 MHz (F4-3600C18D-32GTZR) Graphics Card(s) ASUS ROG-
STRIX-GTX1080TI-O11G-GAMING (11GB GDDR5X) Sound Card Integrated Digital Audio (S/PDIF) Monitor(s) Displays 2 x Samsung Odyssey G75 27" Screen Resolution 2560x1440 Hard Drives 1TB Samsung 990 PRO M.2,4TB Samsung 990 PRO M.2,TerraMaster F8 SSD Plus NAS PSU Seasonic Prime Titanium 850W Case Thermaltake Core P3 wall
mounted Cooling Corsair Hydro H115i Keyboard Logitech wireless K800 Mouse Logitech MX Master 3 Internet Speed 1 Gbps Download and 35 Mbps Upload Browser Chrome and Edge Antivirus Microsoft Defender Other Info Logitech Z625 speaker system,Logitech BRIO 4K Pro webcam,HP Color LaserJet Pro MFP M477fdn,CyberPower
CP1500PFCLCDGalaxy S23 Plus phone Operating System Windows 11 Pro Computer type Laptop Manufacturer/Model Surface Laptop 7 Copilot+ PC CPU Snapdragon X Elite (12 core) 3.42 GHz Memory 16 GB LPDDR5x-7467 MHz Monitor(s) Displays 15" HDR Screen Resolution 2496 x 1664 Hard Drives 1 TB SSD Internet Speed Wi-Fi 7 and
Bluetooth 5.4 Browser Chrome and Edge Antivirus Microsoft Defender Did not realize you could open file explorer with Win + E either. OS Windows 11 Computer type Laptop Manufacturer/Model HP Pavilion Laptop 15-cwlxxx CPU AMD Ryzen 5 3500U with Radeon Vega Mobile Gfx Memory 8.00 GB Graphics Card(s) AMD Radeon(TM) Vega 8
Graphics Sound Card Realtek High Definition Audio Monitor(s) Displays Generic PnP Monitor Screen Resolution 1920x1080 Hard Drives LITEON CV8-8E128-HP (SSD)WDC WD10SPZX-60Z10T0 (Hard Drive) PSU Microsoft ACPI-Compliant Control Method Battery Case Proprietary HP Pavilion Laptop 15 shell Cooling Active Fan Cooling Keyboard
Standard PS/2 Keyboard Mouse ELAN Clickpad Internet Speed 35.50 Mbps download 23.44 Mbps upload Browser Edge Antivirus Windows Defender Operating System Windows 11 24h2 Computer type PC/Desktop Manufacturer/Model Apple iMac "Core i5" 2.7 21.5" (Late 2012) CPU Intel Core i5-3330S Processor Motherboard Ivy Bridge (LGA 1155)
Memory 8.00 GB DDR3 1600 MHz Graphics card(s) NVIDIA GeForce GT 640M Sound Card Cirrus Logic CS4206B (AB 90) Monitor(s) Displays Generic Monitor (iMac) Screen Resolution 1920x1080 Hard Drives APPLE HDD HTS541010A9E662 (Hard Drive 1TB) PSU Integrated Case iMac Aluminum Body Cooling Fan Keyboard HP SK-2085 Mouse
Lenovo Internet Speed 90.8 Mbps download 23.4 Mbps upload Browser Google Chrome Antivirus Windows Defender Option Nine: Oi (Co)Pilot, Open Explorer After updating to 23H2 and the new Explorer, sometimes the address bar list remains flying! Even if I browse the folders inside the window. Is this a bug? Last edited: Dec 17, 2023 OS Win 11
Enterprise Computer type Laptop CPU i7 Hard Drives SSD Option Nine: Oi (Co)Pilot, Open Explorer After updating to 23H2 and the new Explorer, sometimes the address bar list remains flying! Even if I browse the folders inside the window. Is this a bug?View attachment 81308 Just found out this bug yesterday! OS Windows 11 Computer type
Laptop Manufacturer/Model HP Pavilion Laptop 15-cwlxxx CPU AMD Ryzen 5 3500U with Radeon Vega Mobile Gfx Memory 8.00 GB Graphics Card(s) AMD Radeon(TM) Vega 8 Graphics Sound Card Realtek High Definition Audio Monitor(s) Displays Generic PnP Monitor Screen Resolution 1920x1080 Hard Drives LITEON CV8-8E128-HP (SSD)WDC
WD10SPZX-60Z10T0 (Hard Drive) PSU Microsoft ACPI-Compliant Control Method Battery Case Proprietary HP Pavilion Laptop 15 shell Cooling Active Fan Cooling Keyboard Standard PS/2 Keyboard Mouse ELAN Clickpad Internet Speed 35.50 Mbps download 23.44 Mbps upload Browser Edge Antivirus Windows Defender Operating System Windows
11 24h2 Computer type PC/Desktop Manufacturer/Model Apple iMac "Core i5" 2.7 21.5" (Late 2012) CPU Intel Core i5-3330S Processor Motherboard Ivy Bridge (LGA 1155) Memory 8.00 GB DDR3 1600 MHz Graphics card(s) NVIDIA GeForce GT 640M Sound Card Cirrus Logic CS4206B (AB 90) Monitor(s) Displays Generic Monitor (iMac) Screen
Resolution 1920x1080 Hard Drives APPLE HDD HTS541010A9E662 (Hard Drive 1TB) PSU Integrated Case iMac Aluminum Body Cooling Fan Keyboard HP SK-2085 Mouse Lenovo Internet Speed 90.8 Mbps download 23.4 Mbps upload Browser Google Chrome Antivirus Windows Defender I'd like to be able to open a file explorer window with
multiple tabs. I've tried something like this in a command prompt: explorer c: d: I was hoping this would open a window with the first tab being the root of the C drive & the second tab being the root of the D drive. But it just doesn't do that. It seems like explorer accepts only a single argument, & it will open a window with a single tab showing the
directory you specify in the argument. With multiple arguments, it does not open a tab for each argument, but rather always opens on the Documents directory as the only tab. Kind of weird that it doesn't at least open a single tab on the first argument you specify. I don't follow the logic behind opening Documents.If supplying multiple arguments like
my example above is not the right way to do this, then what is? I know well-meaning folks sometimes come up with fancy Power Shell scripts. That's not what I want. I want something simple & intuitive that will work in a regular command prompt. OS Windows 11 Pro 64-bit 24H2 Computer type PC/Desktop Manufacturer/Model Self build CPU Intel
Core i9-13900K Motherboard ASUS Z790-Plus WiFi TUF Gaming Memory 4x32G Teamgroup TForce Vulcan DDR5 6000 DIMMs Graphics Card(s) MSI/NVidia GeForce RTX 4070 Gaming X Trio 12G GDDR6X + built into motherboard Intel UHD Graphics Sound Card Built into graphics card + built into motherboard Realtek Audio Monitor(s) Displays
Both connected to the NVidia adapter - Primary: Dell SE2417HGX 23" diagonal connected via HDMI-to-DisplayPort dongle, Secondary: Toshiba TV 32" diagonal connected via HDMI through Onkyo TX-NR717 surround receiver Screen Resolution 1920x1080 on each monitor Hard Drives Samsung 970 EVO Plus NVMe M.2 2T6xSATA-to-USB 3.0 Fideco
external enclosures holding SATA drives of various brands & sizes 1x20T, 2x18T, 2x6T, 1x500G, all connected to a multi-port USB hubFor backups: USB 3.0 HDDs of various brands & sizes 3x20T, 1x1T + SSDs of various brands & sizes 2x480G, 1x1T, all connected to another multi-port USB hub, powered on only while actually performing backups &
(may it never happen) restores PSU MSI MPG A1000G PCIe5 1000W, TrippLite Smart1500TSU 1200W UPS for the main system, TrippLite ECO850LCD 850W UPS for the DASD & my Internet connectivity boxes (no reason to throw out legacy equipment that stil works fine) Case Fractal North Cooling DeepCool AK620 CPU cooler (air, 2 fans), 2 case
fans, 1 fan in PSU, 3 fans in graphics adapter; 4xpersonal cooling fans strategically placed to cool the external HDDs Keyboard Cherry MX 11900 USB (wired) Mouse Touchpad built into the keyboard Internet Speed 500Mbps via Spectrum cable TV/cell phone bundle Browser Firefox Antivirus Built into Windows 11 Other Info The ethernet adapter
integrated into the motherboard died. I am now using a TPLink TX201 ethernet adapter in a PCle expansion slot for Internet connectivity. File Explorer in Windows 11 is your digital filing cabinet, helping you find, organize, and manage all your files and folders. To use File Explorer, simply click on its icon from the taskbar or press Win + E on your
keyboard. This will open a window where you can browse your computers files, create new folders, and move or copy items. You can also use the search bar to quickly find what youre looking for. File Explorer in Windows 11 is your go-to tool for navigating through your computers files and folders. This section will guide you on how to open, navigate,
and utilize File Explorer effectively. Click the File Explorer icon on the taskbar, or press Win + E on your keyboard. Opening File Explorer is your first step to accessing all your files. The icon often looks like a yellow folder on your taskbar. If youre more of a keyboard person, the shortcut Win + E is your best friend. Use the sidebar on the left to
access different drives and folders. The sidebar is designed to give you quick access to important locations like your Desktop, Documents, and Downloads. Just click on any entry to jump straight to that folder or drive. Enter keywords in the search bar to find specific files or folders. The search bar is a powerful tool that lets you hunt down files without
sifting through countless folders. Just type in a file name or a keyword, and let the search do the rest. Right-click inside any folder and select New > Folder to create a new directory. Organizing files is easier when you have specific folders for different tasks or projects. By right-clicking and selecting New, you can create a folder and name it whatever
makes sense for your needs. Drag and drop to move files, or right-click to copy and paste them to another location. Moving or copying files is as simple as dragging them to a new location. If you want to keep a copy, right-click the file and choose Copy, then right-click where you want it and select Paste. Once you complete these actions, youll be well-
versed in managing your files within Windows 11. Youll find it easier to keep your digital life organized and accessible. Always keep your most-used folders pinned to Quick Access for faster navigation. Use keyboard shortcuts like Ctrl + X, Ctrl + C, and Ctrl + V for cutting, copying, and pasting files. Customize the layout of File Explorer by clicking
View to switch between details, list, or icon views. Regularly back up your important files to an external drive or cloud storage to prevent data loss. Use tags and descriptions in your files to make searching more efficient. You can open multiple File Explorer windows by right-clicking the File Explorer icon on the taskbar and selecting File Explorer.
Yes, open File Explorer, click on the View tab, then options, and set your preferred folder under the General tab. Right-click the file you want to share, and select Share to choose your preferred sharing option. Yes, you can enable the preview pane from the View tab. This allows you to see file contents without fully opening them. Check your Recycle
Bin. If the file is there, you can right-click it and select Restore. Open File Explorer with the icon or Win + E. Navigate using the sidebar. Search for files using the search bar. Create folders via right-click. Move/copy files by dragging or right-clicking. Mastering File Explorer in Windows 11 isnt just about knowing the basicsits about making your
digital workspace efficient and personalized. With the steps and tips above, youre on track to becoming a pro at organizing your digital universe. Think of File Explorer as your digital librarian, ready to help you find, manage, and organize your files with ease. Whether youre a student needing to organize homework, a professional managing work
documents, or just someone looking to tidy up your digital life, File Explorer is an indispensable tool. So, why not give it a try today? Dive into the folder maze, explore, and maybe even discover some cool features along the way. Remember, keeping your files organized not only saves time but also prevents the dreaded digital clutter. For further
reading, explore more advanced File Explorer features like libraries and network sharing, which can elevate your efficiency even more.Matthew Burleigh has been writing tech tutorials since 2008. His writing has appeared on dozens of different websites and been read over 50 million times.After receiving his Bachelors and Masters degrees in
Computer Science he spent several years working in IT management for small businesses. However, he now works full time writing content online and creating websites.His main writing topics include iPhones, Microsoft Office, Google Apps, Android, and Photoshop, but he has also written about many other tech topics as well.Read his full bio here.
By Oluwaseun Bamisile Published September 5, 2022 Need help accessing some of the features in Windows 11 File Explorer? This comprehensive guide offers all the help you need regarding File Explorer in Windows 11. I believe providing you with various ways to open File Explorer is the appropriate place to begin thisguide. Hence, below are two
methods to open File Explorer on your Windows 11 computer. Follow the procedures and screenshots below to open File Explorer on your Windows 11 PC via search. Click the Search icon on the Windows 11 taskbar. Then, type file explorer (without the quotes) in the search field and select the File Explorer app from the search result. After doing
that, File Explorer will open by default on the Quick access page. As the title of this sub-section suggests, you can open File Explorer in Windows 11 by just right-clicking the Start menu. Basically, when you right-click the Start menu, select File Explorer from the options that pop up. You can also open Windows 11 File Explorer via the command
prompt. To use this method to open File Explorer in Windows 11, follow the steps below: Search cmd in Windows 11 search. Then, open Command Prompt from the search results. When the Windows Command Prompt opens, type the command below. Then, press the enter key on your keyboard to open File Explorer from Command Prompt.
explorer.exe This section will explain the Windows 11 File Explorer menus and their functionalities. Windows 11 File Explorers visible menu items are seven, and they perform various functions Cut, Copy, Paste, Rename, Share, Delete, and Sort. The table below explains the functions of these items. S/NVisible Menu ItemsFunctions1Cutlt allows you
to cut selected files or folders in Windows 11 File Explorer2CopyThis allows you to copy a selected file or folder. 3Pastelt allows users to paste a cut or copied file or folder in the same or different location in Windows 11 File Explorer4Renamelt allows users to rename a selected file or folder. 5ShareThis allows users to share a selected file via
email.6DeleteAs the name suggests, this item allows you to delete a selected file or folder in Windows 11 File Explorer7SortThis allows users to adjust how folders or files in Windows 11 File Explorer are sorted. Basically, when you click the Sort drop-down, you can sort folders or files by name, type, date modified, and so much more. As a matter of
fact, you can sort files or folders in ascending or descending order with the Sort drop-down. In the Sort drop-down, you can also group files and folders via the Group by category. You can use the Windows 11 File Explorer View menu to set how files and folders appear. Hence, when you click the View drop-down, you will see various view options see
the screenshot below. However, there is a unique option among the View drop-down options. This option is the Show option. Basically, if you hover your mouse on Show in the View drop-down, another set of options will appear. Thus, you can enable various items you wish to make visible in Windows 11 File Explorer, such as the Preview pane and
Details pane. You may also disable them by selecting them when they are enabled. To know if an item is enabled in the Show category, you will see a checkmark beside it. The See More menu in Windows 11 File Explorer offers various interesting features. In essence, when you click the See More icon in Windows 11 File Explorer, numerous items with
various functions will appear. The functions of these items are explained in the table below. S/NSee More ItemsFunctions1Burn to discThis allows users to burn a selected file in Windows 11 File Explorer to a readable disc 2Pin to Quick access It allows you to pin a selected folder to Quick access in Windows 11 File Explorer3Select allThis allows you
to select all the items in a particular folder opened in File Explorer4Select noneThis clears all your selections in Windows 11 File ExplorerbInvert selectionThis reverses all your current selections in Windows 11 File Explorer6Propertiesit opens the properties of a selected file or folder7OptionsThis is an easy way to open the File Explorer Option in
Windows 11 Keyboard shortcuts improve our productivity while working on a computer. So, this section highlights various File Explorer keyboard shortcuts in Windows 11. File Explorer Keyboard Shortcut Actions Performed by the Keyboard ShortcutCtrl + WClose the active window. The active window is the window you are currently viewingCtrl +
NOpen a new window. If you use this shortcut with a folder open, another window of the folder will open. However, if you press the shortcut with a file active say notepad a new file will openCtrl + FSelect the File Explorer search box. This shortcut selects the search box for the open application. For example, if you are on a webpage when you press
this shortcut, it opens a search box on the top right of the webpage. Ctrl + ESimilar to Ctrl + F select the search box. Alt + DSelect the address bar. If you are on File Explorer, it selects the address bar of File Explorer. However, if you are on a webpage, it selects the address bar of the webpage. Ctrl + mouse scroll wheelChange the size and
appearance of file and folder icons. Ctrl + Shift + EDisplay all folders above the selected folder. Ctrl + Shift + NThis keyboard shortcut creates a new folder. This can be very helpful. Instead of going through 3 steps to create a new folder, you can do it in a single step!Alt + Left arrowUsed to view the previous folder.Alt + Up arrowView the folder
that the current folder was in.Alt + Right arrowView the next folder.Alt + EnterOpen the Properties dialog box for the selected item. This works for Folders or Files. Alt + PThis shortcut displays the preview panel on the right pane of File Explorer. Note that some items may not have a preview. F11 keyMaximize or minimize the open window. Home
keyDisplay the top of the open window.End keyDisplay the bottom of the open window.Left arrow keyIf the current selection is expanded, it collapses it or selects the folder the current folder is in. Right arrow keylf the current selection is collapsed, it expands it, or it selects the first subfolder. Backspace keyView the previous folder. As stated earlier,
File Explorer opens to the Quick access page by default. Furthermore, this page displays commonly accessed folders. Interestingly, you can customize this Quick access page in File Explorer. This implies you can pin or unpin a particular folder or item to the File Explorer Quick access. In the following sub-sections, I1l explain the various ways you can
customize Windows 11 File Explorer. It is quite simple to pin a folder to the Quick access page in Windows 11 File Explorer. Simply right-click the folder you wish to pin and select Pin to Quick access from the options that appear. Other File Explorer items you can pin to Quick access include This PC and Network. Similar to pinning a folder, to pin
these items, right-click the item and selectPin to Quick access from the displayed options. After pinning an item or folder in Windows 11 File Explorer Quick access, you might want to unpin it. Well, this section teaches how to unpin file Explorer items from Quick access. To do that, right-click the pinned item and select Unpin from Quick access from
the displayed options. On the Quick access page in Windows 11 File Explorer, you will see two categories Folders and Recent Files. The Folders category features pinned items and frequently accessed folders. On the other hand, the Recent Files category features recently accessed files. So, in this section, you will learn how to remove frequently
accessed folders and recently accessed files from these categories. Follow the steps below to remove frequently accessed folders and recently accessed files from the Quick access page in Windows 11 File Explorer. Click the Windows 11 Search icon on the taskbar and type file explorer options in the search field. Then, select File Explorer Options
from the search result. Afterward, locate the Privacy category in the General tab on the File Explorer Options window. Then, under this category, uncheck the Show recently used files in Quick access and/or Show frequently used folders in Quick access boxes. Finally, click the OK button at the bottom of the window to save the changes. Hence, when
you open File Explorer Quick access, you will notice the frequently accessed folders and recently accessed files are gone! The Documents folder is arguably one of the most accessed folders on a computer. Hence, in this section, you will learn how to access this folder in Windows 11 File Explorer. By default, the Documents folder is pinned to the File
Explorer Quick access. Hence, once you open File Explorer in Windows 11, you can easily access the Documents folder beneath Quick access. However, if you previously unpinned the Documents folder from your Windows 11 File Explorer Quick access, follow the steps below to pin it. Open File Explorer by right-clicking the Windows 11 Start menu
and selecting File Explorer from the displayed options. Then, select This PC on the left pane of the File Explorer window. Afterward, double-click Local Disk (C:) under the Devices and drives category or the drive your Windows 11 is installed. Next, double-click the User folder to open it. Then, select the folder with the name of the Windows 11 profile
that you are currently logged in. For this demonstration, I will be selecting the Fire Hub 019 folder. Finally, right-click the Documents folder and select Pin to Quick access. This section teaches how to perform various common tasks in Windows 11 File Explorer. If you want to print a file or document while in File Explorer, right-click the file or
document and select Show more options. Then, click Print from the options that appear, and the document should print to your default printer. Impressively, you can also print multiple documents via File Explorer in Windows 11. To do that: 1. Lleft-click the first document to select it. Then, click the other documents you wish to print together while
pressing the Ctrl key on your keyboard. Next, right-click any one of the selected documents and click Show more options. Finally, click Print from the options that appear, and the documents should be sent to your default printer. Although Windows 11 File Explorer doesnt have an image/photo resize option, Windows 11 Photos app has a resize option.
So, follow the steps below to resize an image via the Photos app in Windows 11. Click the Windows 11 Search icon and type photos in the search field. Then, select the Photos app from the search result. Afterward, click the Import icon in the Photos app and select From a folder. Next, select the folder you want to import the image from on the Select
folder window. Then, click the Import items from this folder button at the bottom of the window. On the Import items page, select the image you want to resize and click the blue import button at the bottom of the page. Following that, select the image you imported, which you plan to resize. Then, click the See more (three horizontal dots) icon at the
top of the window and select Resize. Finally, select a pre-defined size from the options, if available. You may also select Define custom dimensions to resize your image with custom dimensions. There are two ways you can delete an image or photo in Windows 11 File Explorer. You can right-click the photo you want to delete and select the Delete icon
from the displayed options. Alternatively, you can select the image you want to delete by left-clicking it. Then, click the Delete key on your keyboard. In addition to deleting a photo in Windows 11 File Explorer, you can also delete a photo via the Windows 11 Photos app. Follow the steps below to achieve that. After opening the Photos app in Windows
11, hover your mouse cursor on the photo you wish to delete. Then, check the box at the top right edge of the photo. With the photo selected, click the See more icon at the windows top right corner and select Delete. Finally, you will receive a pop-up asking if you are sure you want to delete the photo. Click Delete to proceed. To save any file in
Windows 11 File Explorer WordPad and notepad files click the File menu at the top left corner of the window. Then, select Save or Save As from the displayed options. Some of our readers reported that when they launch Windows 11 File Explorer, it shows the names of the folders/files. Hence, these readers need help setting up Windows 11 File
Explorer to show folders/files in thumbnail view. To do that, click the View menu on the File Explorer window and select either Extra large icons or Large icons. 6. Increase Text Size Changing the view to the thumbnail is aneasy wayto increasethe size of Windows 11 File Explorer texts. To do that, read the previous section, How To Change File
Explorer To Thumbnail View. However, that changes mainly the view, not particularly the texts in File Explorer. Sadly, Windows 11 File Explorer doesnt have a built-in function that allows you to increase the size of texts. Thankfully, Windows 11 has a feature that allows you to increase the text size of most applications, including File Explorer. Hence,
follow the steps below to enable this feature. Right-click the Windows 11 Start menu and select Settings. Then, select Accessibility on the left pane of the Settings window. Afterward, click Text size. Finally, with the Text size slider, you can modify the text size in Windows 11. After doing that, click the Apply button to save the change. The quickest
way to open File Explorer Options in Windows 11 is via search. Click the Search icon on your Windows 11 taskbar and type file explorer options (without the quotes). Then, left-click File Explorer Options from the search result to open it. Impressively, you can also open File Explorer Options in Windows 11 via the control panel. Follow the steps below
to do that. Click the Windows 11 Search icon and type control panel in the search field. Then, select the Control Panel from the search result. After that, click the View by drop-down and select Small icons. Finally, select File Explorer Options. Apart from opening File Explorer Options via search and control panel, you can also open it via File Explorer.
To do that, click the See more icon in the File Explorer window and select Options from the displayed options. File Explorer in Windows 11 has a preview pane. If you enable the preview pane, you will see a preview of the content you selected in File Explorer. So, follow the steps below to enable the Windows 11 File Explorer preview pane. Click the
View menu on the File Explorer window and hover your mouse cursor on Show. Then, select Preview pane from the displayed options. Hence, anytime you select a file, Windows 11 File Explorer will display a preview on the windows right pane. 1. Is File Explorer different in Windows 11 compared to Windows 11? The functionality of File Explorer in
Windows 11 and Windows 10 is totally the same. However, their user interfaces are different read Windows 10 vs Windows 11: File Explorer to know more. 2. How do you open File Explorer in Windows 11? Follow the steps below to open File Explorer on your Windows 11 PC. a) Click the Windows 11 Search icon on the taskbar. b) Then, type file
explorer in the input field.c) Finally, select File Explorer from the search result. 3. When was File Explorer introduced? Windows File Explorer was introduced on 15th August 1995. 4. What is File Explorer? File Explorer, formally known as Windows Explorer, is a file manager app that is included in Windows computers. Furthermore, it allows you to
browse files and folders on your Windows PC. 5. What is the shortcut to open File Explorer in Windows 11? The keyboard shortcut to open File Explorer in Windows 11 is Windows key + E. File Explorer in Windows 11 is a useful app that allows users to browse folders and files. However, some people might find it difficult to access Windows 11 File
Explorers features. Gladly, this Get Help With File Explorer In Windows 11 article fixes that. This guide explained how to use most of the Windows 11 File Explorer features. As a matter of fact, we discussed various methods to open File Explorer in Windows 11. Also, I provided numerous Windows 11 File Explorer keyboard shortcuts in this guide so
as to boost your productivity. All in all, with this guide, File Explorer in Windows 11 has never been easier to use! Did you find this Windows 11 File Explorer help guide helpful? If you find it helpful, click on Yes beside the Was this page helpful question below. You may also express your thoughts and opinions by using the Leave a Comment form at
the bottom of this page. Finally, visit our Windows 11 How-Topage for more Windows 11 how-to guides.Was this page helpful?Yes (1)No (0) About the Author Oluwaseun Bamisile Related Articles We're committed to writing accurate content that informs and educates. To learn more, read our Content Writing Policy, Content Review Policy, Anti-
plagiarism Policy, and About Us. However, if this content does not meet your expectations, kindly reach out to us through one of the following means: Respond to "Was this page helpful?" above Leave a comment with the "Leave a Comment" form below Email us at [emailprotected] or via the Contact Us page. File Explorer is one of the most important
parts of the Windows operating system. It helps users view, manage, and organize their files and folders. If you want to open documents, move photos, search for files, or plug in a USB drive, File Explorer is the tool you use. While it usually works well, sometimes users may face problems or need help using certain features. This article will guide you
step-by-step on how to get help with File Explorer in Windows 10 and Windows 11.We will cover how to open File Explorer, use it effectively, fix common issues, and where to find support if something goes wrong. This article is made for everyone, including beginners. The goal is to help you understand and solve problems on your own. What is File
ExplorerFile Explorer is a built-in application in Windows that shows you all the files and folders stored on your computer. It was called Windows Explorer in older versions. File Explorer lets you move, copy, rename, delete, and organize files. It also helps you access storage devices like hard drives and USB sticks.You can find documents, pictures,
music, downloads, and more inside File Explorer. You can open many windows at once and work with different folders side by side. It also lets you sort, search, and view files in different ways.How to Open File Explorer in Windows 10 and 11There are several easy ways to open File Explorer:Click the yellow folder icon on the taskbarPress the
Windows key + E on your keyboardRight-click the Start menu and select File ExplorerOpen Start and type File Explorer in the search bar, then click the resultAny of these methods will open a new File Explorer window. It usually starts in Quick Access, where you see recent files and frequently used folders.Main Sections of File ExplorerWhen you
open File Explorer, you will see a window with several parts:Navigation pane: On the left, you will see folders like Desktop, Documents, Pictures, Downloads, and This PC. You can click them to open quickly.Address bar: This shows your current folder location. You can type a location or use the drop-down menu to move around.File list: The main area
shows the contents of the folder you are in. You can double-click a folder to open it.Ribbon menu: At the top, there are options like New Folder, Copy, Paste, and Properties. These change based on what you have selected.Search bar: At the top-right corner, you can search for files and folders by name or keyword.Using File Explorer to Organize
FilesFile Explorer lets you do many things with files:To create a folder, right-click in any empty space, choose New then Folder, and give it a name.To rename a file, right-click it and choose Rename, or click it once and press F2.To copy or move a file, select it and use right-click > Copy or Cut. Then go to the new location and right-click > Paste.To
delete a file, right-click and choose Delete, or select and press the Delete key. Deleted files usually go to the Recycle Bin unless removed permanently.To view details, right-click the file and choose Properties. This shows size, date created, and other information.These steps work the same way in both Windows 10 and Windows 11.Changing View and
Sorting OptionsFile Explorer gives you several ways to view files:Click the View tab on the top menuChoose options like List, Details, Large Icons, or TilesUse the Sort by option to arrange files by name, size, date, or typeGroup files by similar details using Group byChanging the view helps you find and manage files more easily. You can also enable or
disable file extensions and hidden files from the View tab.Using Quick Access and This PCQuick Access is a feature that shows your most used folders and recently opened files. You can pin folders you use often so they are always easy to find.To pin a folder:Right-click any folderSelect Pin to Quick accessTo remove it:Right-click the pinned
folderChoose Unpin from Quick access or click the Pin to Quick Access againThis PC shows all your drives and main folders like Documents, Music, and Videos. It also shows how much storage you have left on each drive.Searching for Files in File ExplorerThe search bar at the top-right of File Explorer lets you find files by name or content. Just type a
word or part of the name and press Enter. The system will search in the current folder and its subfolders.Tips for faster searching:Type file extensions like *.docx or *.jpg to find file typesUse filters like date modified, size, or keywords in file contentBe patient when searching large foldersYou can also go to the Search tab after typing to see more
search tools.Fixing Common File Explorer ProblemsSometimes File Explorer may not work as expected. Here are common issues and how to fix them: Try these solutions:Restart your computerPress Ctrl + Shift + Esc to open Task Manager, find Windows Explorer and click RestartRun Windows Update to get the latest fixesScan your system with
antivirus software in case of malware Fix it by:Clearing Quick Access history: Open File Explorer Options > ClearDisabling preview pane: Go to View tab and uncheck Preview paneUpdating your system and drivers Try:Opening in Safe Mode to check if another app is causing issuesRunning System File Checker: Open Command Prompt and type sfc
/scannowCreating a new user account to see if the problem is user-specific If you cannot find a file:Check the Recycle BinUse the search barMake sure Hidden files are visible in View settingsUse File History or Backup if set upThese solutions usually solve most problems users face with File Explorer.How to Reset File Explorer Settingslf File Explorer
settings are changed and you want to go back to default:Open File ExplorerClick View tab and choose Optionsin Folder Options, go to General tab and click Restore DefaultsDo the same in the View tabClick Apply and OK. This will reset view settings and Quick Access behavior.Using File Explorer Tabs in Windows 11Windows 11 introduced a useful
feature that was not available in earlier versions: tabs in File Explorer. This feature allows you to open multiple folders in one window, just like using tabs in a web browser. This makes multitasking easier and helps keep your screen tidy.To open a new tab:Press Ctrl + TOr click the + button at the top of the File Explorer windowTo close a tab:Press
Ctrl + WOr click the X on the tabYou can drag tabs to reorder them or right-click a tab for more options. This feature is currently only available in Windows 11, and it works very smoothly.Keyboard Shortcuts for File ExplorerHere are some helpful keyboard shortcuts that can make using File Explorer faster:Windows + E Open File ExplorerCtrl + N
Open a new File Explorer windowCtrl + T Open a new tab (Windows 11 only)Alt + Left Arrow Go backAlt + Right Arrow Go forwardAlt + Up Arrow Go one level upCtrl + C / Ctrl + X / Ctrl + V Copy / Cut / PasteF2 Rename selected itemDelete Move selected item to Recycle BinShift + Delete Permanently delete itemCtrl + Z Undo last actionThese
shortcuts work in both Windows 10 and 11, except for tab features which are only in Windows 11.Check out: How to Enable or Turn Off BitLocker on Windows 11Customising File Explorer SettingsYou can make File Explorer behave the way you like by changing its settings.To open settings:In File Explorer, click on the View tabChoose Options or
Folder OptionsIn the General tab:You can change whether File Explorer opens to Quick Access or This PCYou can show or hide recently used files and foldersYou can enable or disable single-click to open itemsIn the View tab:You can choose to show hidden files and foldersYou can show file extensions for known typesYou can reset the view to default
if neededThese settings help you control how you interact with files and folders.File Explorer Integration with OneDriveln both Windows 10 and Windows 11, OneDrive is built into File Explorer. This means your cloud files appear alongside local files.You can find OneDrive in the navigation pane on the left side. If you are signed in with your Microsoft
account, files in your OneDrive will be synced and backed up to the cloud.Features include:Automatic syncing of filesOffline access to recent filesEasy sharing of files by linkFreeing up space with the Free up space optionThis is useful if you want to back up important folders like Documents or Pictures without using a USB drive or external hard
disk.Troubleshooting OneDrive Issues in File ExplorerSometimes users face problems with OneDrive not syncing or not showing up. Heres what you can do:Make sure you are signed into your Microsoft accountRight-click the OneDrive icon in the taskbar and choose SettingsGo to the Account tab and check if your folders are selected for



syncingRestart the OneDrive appRun the built-in troubleshooter: Go to Settings > System > Troubleshoot > Other troubleshooters > OneDrivelf the problem continues, visit the official Microsoft support site for help.File Explorer and External DevicesWhen you plug in a USB drive, external hard disk, or SD card, File Explorer should show it under
This PC or Devices and Drives. You can open it, move files, and safely remove it afterward.If the device does not show up:Try using a different USB portCheck if the device works on another computerOpen Disk Management (Windows + X > Disk Management) to see if it appears thereAssign a drive letter if neededUpdate USB drivers in Device
ManagerThese steps help fix issues with external devices not appearing in File Explorer.How to Reinstall or Repair File ExplorerIf File Explorer is badly broken and nothing else works, you can try repairing or resetting it. Windows does not allow uninstalling File Explorer, but you can reset system components.Options include:Running the System File
Checker (sfc /scannow)Running the DISM Tool (DISM /Online /Cleanup-Image /RestoreHealth)Creating a new user accountPerforming a Repair Install of Windows using the Media Creation ToolThese advanced steps are safe if followed carefully and can fix deep issues in the system.When to Seek Professional HelpIf File Explorer problems do not go
away even after troubleshooting, it may be time to contact professional support. You can: It is important not to modify system files or download third-party fix tools from unknown sources. They may cause more harm than good.ConclusionFile Explorer is more than just a tool to browse files. It plays a big role in daily computer use. Whether you are a
student, employee, or home user, knowing how to use and fix File Explorer will make your work smoother and save time.This guide showed you how to open File Explorer, organize files, change settings, solve problems, and use advanced features like tabs and cloud syncing. With these steps, you can take full control of how you use your
computer.Always keep your system updated, stay aware of new features, and never hesitate to ask for help when you need it. With this knowledge, you are now ready to explore, manage, and troubleshoot files in Windows 10 and 11 with ease.Read more:Why You Should Go Passwordless Using Windows Hello on Windows File Explorer is a
fundamental part of the Windows operating system, serving as the primary interface for managing files and folders. Whether youre navigating through your documents, seeking specific files, or organizing your digital workspace, understanding how to effectively use and troubleshoot File Explorer is essential. In this detailed article, we will explore
various aspects of getting help with File Explorer in both Windows 11 and Windows 10, from the built-in support resources to third-party solutions.Understanding File ExplorerBefore delving into getting help with File Explorer, its critical to grasp what it is and its significance. File Explorer (previously known as Windows Explorer) allows users
to:Navigate their file system effortlesslyOrganize files and foldersAccess network storageManage cloud storage (e.g., OneDrive)Share files and folders with othersKnowing how to utilize File Explorer efficiently can make a considerable difference in your overall user experience.Common Issues with File ExplorerWhile File Explorer is a robust tool,
users often encounter issues from time to time. Some common problems include:File Explorer freezing or crashinglIssues with search functionalitySlow performance when opening or navigating foldersProblems with file previews and thumbnailsMissing or corrupt filesUnderstanding these common issues will assist you in targeting your
troubleshooting efforts effectively.In-Built Help Options in Windows 11 and Windows 101. Windows Help and SupportBoth Windows 10 and 11 come equipped with comprehensive help resources. You can access this feature by:Pressing the F1 key within File Explorer. This will launch the official help documentation in your default web browser.Going
to Settings > Help to access additional resources.The help menu includes articles related to common tasks, troubleshooting, and best practices for using File Explorer.2. Quick Actions in the ToolbarFile Explorer features a Ribbon tool at the top, which includes various functionalities. If you need assistance, look for the View tab, which allows you to
customize your file management experience. You can enable features such as:Previewing itemsEnabling hidden itemsChanging folder optionsTaking time to explore these features can enhance your understanding and efficiency in using File Explorer.3. File Explorer OptionsIf youre facing usability issues or specific quirks in how File Explorer
operates, exploring the File Explorer Options can help. Open File Explorer.Click on the View tab in the Ribbon.Select Options.From here, you can modify settings related to how folders and files are displayed, tweak file path behavior, and change advanced settings that dictate how File Explorer interacts with your files.4. Windows Search BarThe
search feature available in both Windows 10 and 11 can be invaluable when trying to find help regarding File Explorer issues. By typing keywords into the taskbar search bar, you can quickly access articles, forums, and even settings related to your query.5. Windows Feedback Hublf youre encountering issues not covered in the help resources,
consider using the Windows Feedback Hub:Press the Windows key + F to launch the Feedback Hub.Report your file-related issues for potential fixes or workarounds. This tool allows you to see if others have similar problems, and Microsoft often responds or issues patches for common conundrums.Utilizing the Microsoft Support WebsiteMicrosofts
official support website is an excellent resource for troubleshooting and getting advice related to File Explorer issues. Heres how to navigate it:Go to support.microsoft.com and enter File Explorer in the search bar.Scour through the articles, FAQs, and guides available.Use the community forums to engage with other users who may have faced similar
issues.These resources often include step-by-step instructions to resolve common problems, tips for optimizing performance, and even video tutorials.Community Forums for SupportThe Windows community forum is another vibrant place to seek help. Here are a few steps to follow:Visit the Microsoft Community page.Search for your particular File
Explorer problem.Engage in discussions or create a new post if you cannot find an existing solution.Community members, including Microsoft MVPs and avid users, often provide helpful insights, fixes, and shared experiences.Advanced Troubleshooting TechniquesUpdate Drivers Fix Your PC If standard support does not resolve your File Explorer
issues, consider advanced troubleshooting techniques.1. Running the Windows TroubleshooterWindows includes a built-in troubleshooter to help identify and fix common system issues, including those that may affect File Explorer.Go to Settings > System > Troubleshoot > Other troubleshooters.Locate File and Folder Troubleshooter and run it to
diagnose any potential issues.2. Resetting File ExplorerlIf File Explorer consistently behaves incorrectly, you may want to reset it:Open the Task Manager by right-clicking the taskbar and selecting it.Find Windows Explorer in the list of processes.Right-click it and choose Restart.Resetting can often clear temporary glitches that cause performance
issues.3. Checking for Windows UpdatesOften, issues with File Explorer can stem from outdated software:Go to Settings > Update and Security > Windows Update.Check for any available updates and install them.Updates may contain patches and fixes that resolve existing problems.4. Execution of System File CheckerSometimes, system files
associated with File Explorer can become corrupt. To restore these files, execute the System File Checker (SFC):Open the Command Prompt as an administrator.Type sfc /scannow and press Enter.This process can take some time, but if it finds any corrupted files, it will attempt to repair them automatically.5. Rebuilding the Search IndexIf your
search functionality is sluggish or unresponsive, consider rebuilding your search index:Go to Control Panel > Indexing Options.Click on Advanced and then select Rebuild.This process can help improve search accuracy and speed in File Explorer.Using Third-Party ToolsSometimes, Windows built-in tools may not address all your needs. When that
happens, third-party software can provide alternative solutions.1. File Management ToolsSeveral third-party file management tools offer extensive features beyond what File Explorer provides. Programs like Total Commander or Directory Opus allow for multi-pane views, tabbed browsing, and enhanced file preview options. These tools often have
extensive support documentation that caters to various user needs.2. Cleaner SoftwareFile Explorer issues can arise unless your system is adequately maintained. Cleaner tools like CCleaner can help tidy up unwanted files and optimize system performance, potentially easing problems with File Explorer.3. Community-Created Scripts and ToolsThe
tech community often creates scripts or small utilities designed to enhance or troubleshoot File Explorer. Websites like GitHub host numerous projects that can be downloaded for specific file management needs.Frequently Asked Questions (FAQs)Why does File Explorer keep crashing?Driver Updater - Update Drivers Automatically File Explorer
crashes can often result from software conflicts, corrupted files, or plugin issues. Running the SFC scan or resetting File Explorer may help.How can I troubleshoot the search function in File Explorer?To troubleshoot search issues, rebuild the search index, check for updates, and ensure your Windows settings are correctly configured to allow
indexing.Is there any way to customize the File Explorer interface?Yes, you can customize File Explorer by changing the layout, modifying ribbon options, or selecting which folders display in Quick Access.What should I do if I cant find a file?Use the built-in search feature of File Explorer, and ensure you check in hidden and system folders if
necessary. Utilize external search tools if needed.Can I repair File Explorer without reinstalling Windows?Yes, running the SFC command, resetting File Explorer, or performing a system restore can often fix problems without a full reinstall. ConclusionUpdate Drivers Fix Your PC Getting help with File Explorer in Windows 10 and 11 encompasses
understanding built-in tools, leveraging community resources, and using advanced troubleshooting techniques. From engaging with Microsofts support to exploring third-party tools, a wealth of options is available to enhance your experience and resolve common issues.By actively utilizing the resources and techniques outlined in this article, you can
optimize your Windows file management experience, ensuring that File Explorer becomes a reliable ally in your daily productivity tasks. Never hesitate to reach out for help, whether through Microsofts official channels or user communities, because effective file management is crucial in our increasingly digital world.
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